
Bare Metal Server

Quick Start

Issue 01

Date 2018-06-20



Contents

1 Registering an Account in the Public Cloud System............................................................. 1

2 Creating a Key Pair........................................................................................................................2

3 Purchasing a BMS..........................................................................................................................6

4 Logging In to a Linux BMS........................................................................................................13
4.1 Login Using an SSH Key............................................................................................................................................. 13
4.2 Login Using an SSH Password.....................................................................................................................................15
4.3 Remote Login............................................................................................................................................................... 16

5 Logging In to a Windows BMS.................................................................................................17
5.1 Login Using an MSTSC Password...............................................................................................................................17

6 Initializing Data Disks............................................................................................................... 18

7 (Optional) Installing One-Click Password Reset Plugins...................................................23

8 Change History............................................................................................................................ 27

Bare Metal Server
Quick Start Contents

Issue 01 (2018-06-20) ii



1 Registering an Account in the Public Cloud

System

If you have registered on the public cloud platform, you can log in to the management console
and access your BMSs. If you have not registered, register yourself on the public cloud. This
section describes how to register an account on the public cloud website. After the
registration, your account can be used to access all public cloud services, including your
BMSs.

Procedure
1. Log in to the HUAWEI CLOUD website http://www.huaweicloud.com/en-us/.
2. Click Register.

On the displayed Register page, register an account as prompted. For details, see
Register on HUAWEI CLOUD Management Console.
After you have successfully registered, the system automatically redirects you to your
personal information page.
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2 Creating a Key Pair

Scenarios
To ensure system security, you are recommended to use the key authentication mode to
authorize the user who attempts to log in to a BMS. Therefore, you must use an existing key
pair or create a new one for remote login authentication.

l Creating a key pair
If no key pair is available, create one that contains a public and private key used for login
authentication. You can use either of the following methods:
– Create a key pair using the management console. After the creation, the public key

is automatically stored in the system, and the private key is manually stored in a
local directory. For details, see section Creating a Key Pair Using the
Management Console.

– Create a key pair using puttygen.exe. After the creation, both the public key and
private key are stored locally. For details, see section Creating a Key Pair Using
puttygen.exe.

l Using an existing key pair
If a key pair is available locally, choose Key Pair in the navigation tree and click
Import Key Pair and Select File on the right side of the page to import the key pair to
the system. For details, see section Importing a Key Pair.

Restrictions and Limitations
l BMSs support the following encryption algorithms:

– SSH-2 (RSA, 1024)
– SSH-2 (RSA, 2048)
– SSH-2 (RSA, 4096)

l The private key is one of the most important functions for protecting your BMS during
SSH login. To ensure BMS security, you are limited to downloading the private key only
once.

Creating a Key Pair Using the Management Console
1. Log in to the management console.

2. Click  in the upper left corner and select the region and project.
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3. Under Computing, click Bare Metal Server.
4. In the navigation tree, choose Key Pair.
5. On the right side of the page, click Create Key Pair.
6. Enter the key name.
7. Click OK.
8. In the displayed dialog box, click OK.

You can view and save the private key according to the prompts. To ensure BMS
security, you are limited to downloading the private key only once.

Creating a Key Pair Using puttygen.exe

Step 1 Obtain the public and private keys.

1. Double-click puttygen.exe. The PuTTY Key Generator page is displayed.

Figure 2-1 PuTTY Key Generator

2. Click Generate.
The key generator automatically generates a key pair that consists of a public key and a
private key. The public key is shown in the red box in Figure 2-2.
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Figure 2-2 Obtaining the public and private keys

Step 2 Copy the public key content to a .txt file and save the file in a local directory.

NOTE

Do not save the public key by clicking Save public key. Storing a public key by clicking Save public
key of puttygen.exe will change the format of the public key content. Such a key cannot be imported to
the management console.

Step 3 Save the private key file.

The format in which to save your private key varies depending on application scenarios: To
ensure BMS security, you are limited to downloading the private key only once.

l Saving the private key in .ppk format
When you are required to log in to a Linux BMS using PuTTY, you must use the .ppk
private key. To save the private key in .ppk format, perform the following operations:

a. On the PuTTY Key Generator page, choose File > Save private key.
b. Save the private key, for example, kp-123.ppk, to the local PC.

l Saving the private key in .pem format
When you are required to log in to a Linux BMS using Xshell or attempt to obtain the
password for logging in to a Windows BMS, you must use the .pem private key for
authentication. To save the private key in .ppk format, perform the following operations:

a. On the PuTTY Key Generator page, choose Conversions > Export Open SSH
key.
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NOTICE
If you use this private file to obtain the password for logging in to a Windows BMS,
when you choose Export OpenSSH key, do not configure Key passphrase.
Otherwise, obtaining the password will fail.

b. Save the private key, for example, kp-123.pem, in a local directory.

Step 4 Import the public key to the system. For details, see "Copying the public key content".

----End

Importing a Key Pair
If you store a public key by clicking Save public key of puttygen.exe, the format of the
public key content will change. Such a key cannot be imported to the management console.
To resolve this issue, obtain the public key content in correct format and import the content to
the management console. For details, see What Should I Do If a Key Pair Created Using
puttygen.exe Cannot Be Imported to the Management Console?

1. Log in to the management console.

2. Click  in the upper left corner and select the region and project.
3. Under Computing, click Bare Metal Server.
4. In the navigation tree, choose Key Pair.
5. On the right side of the page, click Import Key Pair.
6. Use either of the following methods to import the key pair:

– Selecting a file

i. On the Import Key Pair page, click Select File and select the locally stored
public key.

NOTE

When importing a key pair, ensure that the public key is imported. Otherwise,
importing the key pair will fail.

ii. Click OK.
After the public key is imported, you can change its name.

– Copying the public key content

i. Copy the content of the public key in .txt file into the Public Key Content text
box.

ii. Click OK.
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3 Purchasing a BMS

Scenarios
This section describes how to purchase a BMS so that you can deploy your services on it.

Precautions
Dedicated physical resources

l To make a BMS run on isolated physical hardware, apply for a Dedicated Computing
Cluster (DCC) and then create a BMS.
For details about DCC, see Dedicated Computing Cluster User Guide.

l If you want your BMS to exclusively use a storage device, apply for Dedicated
Enterprise Storage Service (DESS) after you enable DCC and then create the BMS.
For details about DESS, see Dedicated Enterprise Storage Service User Guide.

Procedure
1. Log in to the management console.

2. Click  in the upper left corner and select the region and project.
3. Under Computing, click Bare Metal Server.

The BMS console is displayed.
4. Click Buy BMS.

The page for you to purchase a BMS is displayed.

NOTE

If you have obtained a DCC and want to deploy your BMS in your DCC, click Provision BMS in
DeC.

5. Confirm Region.

If the region is incorrect, click  in the upper left corner of the page for correction.
6. Set AZ.

An AZ is a physical region where power and networks are physically isolated. AZs in the
same region can communicate with each other over an intranet. It is recommended that
you apply for BMSs in different AZs to ensure high availability of applications running
on the BMSs.
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7. Set Flavor.
The flavor contains the CPU, memory, local disks, and extended configuration of the
BMS. After you select a flavor, the name, networking, and use scenarios of the flavor are
displayed under the flavor list.

NOTE

Configuration in the flavor, such as CPUs, memory, and local disks, cannot be changed.

The bandwidth of different BMS flavors varies. Choose a flavor that meets your requirements.

8. Set Image.
– Public Image

A public image is a standard, widely used image. It contains an OS and preinstalled
public applications and is available to all users.
To select a public image, set Image Type to Public Image and choose a desired one
from the Image drop-down lists.

– Private Image
A private image is an image available only to the user who created it using an
external image. It contains an OS, SDI card driver, bms-network-config network
configuration program, Cloud-Init, and users' private applications.
To select a private image, set Image Type to Private Image and choose a desired
one from the Image drop-down list.

– Shared Image
A shared image is a private image shared by another public cloud user with you.
To select a shared image, click the Shared Image tab and select a desired one from
the Image drop-down list.

9. Select License Type.
Specifies a license type for using an OS or software on the public cloud platform. This
parameter is available only if the image you selected is charged.
– Buy licenses from platform

Allows you to use the license provided by the public cloud platform. Obtaining the
authorization of such a license is charged.

– Bring your own licenses (BYOL)
Allows you to use your existing OS license. In such a case, you do not need to
apply for a license again.

10. Set Storage.
Disks are classified as EVS disks, DSS disks, and DESS disks based on whether the
storage resources used by the disks are exclusive. Currently, you can only select one disk
type.
– EVS: provides secure, reliable, and scalable hard disk resources of various flavors

to meet performance requirements in different scenarios.
If you have not applied for an exclusive storage pool, click the EVS tab and create
EVS disks that use public storage resources.

– DSS: provides exclusive storage resources, high availability and durability, and
stable and low latency using multiple technologies, such as data redundancy and
cache acceleration.
If you have obtained a DSS storage pool, click the DSS tab and create disks in the
obtained storage pool.
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– DESS: provides dedicated storage devices for enterprises to migrate key services
(such as Oracle RAC and SAP HANA TDI) to the cloud.

If you have enabled the Dedicated Enterprise Storage Service (DESS), click the
DESS tab and create disks in DESS.

A disk can be a system or data disk. You can add multiple data disks to a BMS and
customize the system disk size.

– System disk

If you select a flavor that supports quick provisioning, the system disk is available.
You can set the disk type and size as needed.

– Data disk

You can add multiple data disks to a BMS and configure sharing for each data disk.

n Currently, BMSs only support SCSI disks.

n Share: indicates that the disk is shared. A shared disk can be attached to
multiple BMSs.

NOTE

l After a system disk is detached from a BMS charged in yearly/monthly mode, the disk can
only be used as a system disk and can only be attached to this BMS.

l If you detach a non-shared data disk purchased when you buy a BMS charged in yearly/
monthly mode and want to attach it again, you can only attach it to the original BMS as a data
disk.

l The non-shared data disk purchased when you buy a BMS charged in yearly/monthly mode
does not support separate renewal, unsubscription, automatic service renewal, conversion to
on-demand payment, and release.

11. Configure automatic backup.

After automatic backup is enabled, the system automatically backs up the BMS based on
the preset backup policy.

NOTE

The automatic backup function applies only to BMSs that support quick provisioning. To enable
this function, you must select a flavor that supports quick provisioning in step 7.

a. Select Enable.

b. Configure Backup Policy.

In the drop-down list, select a backup policy. Alternatively, you can click Manage
Backup Policy and set the backup policy on the Cloud Server Backup Service
(CSBS) page. If you have not created any backup policy but have selected Enable,
the system will use the default backup policy, as shown in Figure 3-1.

Figure 3-1 Default backup policy

For more information about BMS backup, see the Cloud Server Backup Service User
Guide.

12. Set network parameters, including VPC, Security Group, and NIC.
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Table 3-1 Network parameters

Parameter Description

VPC If you do not have a VPC configured when creating a BMS for
the first time, the system creates the default VPC, subnet, and
security group for you. The default subnet segment is
192.168.0.0/24 and the subnet gateway is 192.168.1.1. Dynamic
Host Configuration Protocol (DHCP) is enabled for the subnet.
If the default VPC cannot meet your network requirements, click
View VPC to create a VPC.

Security Group A security group implements access control for BMSs within a
security group and between different security groups. You can
define different access control rules for a security group, and
these rules take effect for all BMSs added to this security group.
When purchasing a BMS, you can select the security group to
which it belongs. You can select only one security group when
applying for a BMS.
Security group rules determine BMS access and usage. For
instructions about how to configure a security group rule, see
Configuring the Security Group.
NOTE

Before initializing a BMS, ensure that security group rules in the
outbound direction meet the following requirements:

l Protocol: TCP

l Port Range: 80

l Remote End: 169.254.0.0/16

If you use the default outbound security group rule, the preceding
requirements are met, and the BMS can be initialized. The default
outbound security group rule is as follows:

l Protocol: Any

l Port Range: Any

l Remote End: 0.0.0.0/16

NIC Specifies the BMS NIC. The system provides a primary NIC by
default. You can specify the IP address to use for the primary
NIC in your VPC. You can add extended NICs to the BMS.

High-Speed NIC Specifies the NIC that is assigned an IP address from the high-
speed network segment. A high-speed NIC provides higher
bandwidth for a BMS. A BMS can have a maximum number of
two high-speed NICs. You can configure the IP address to be
used by the high-speed NIC.
NOTE

If you use a high-speed NIC, you cannot create BMSs in batches.
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Parameter Description

EIP An elastic IP address (EIP) is a public IP address. You can bind
EIPs to BMSs on a routed network, making services in a VPC
accessible to external services.
You can select one of the following three options for EIP as
required:
l Do Not Use: The BMS cannot communicate with the Internet

and can only be used to deploy services or clusters in a
private network.

l Automatically Assign: The system automatically assigns an
EIP with a dedicated bandwidth to the BMS. The bandwidth
is configurable.

l Specify: An existing EIP is assigned to the BMS.

Flavor This parameter is mandatory when EIP is set to Automatically
Assign.
l Dynamic BGP: When changes occur on a network using

dynamic BGP, routing protocols provide automatic, real-time
optimization of network configurations, ensuring network
stability and optimal user experience.

l Static BGP: When changes occur on a network using static
BGP, carriers cannot adjust network configurations in real
time to ensure optimal user experience.

Charging Mode This parameter is mandatory when EIP is set to Automatically
Assign.
By bandwidth: You specify a maximum bandwidth and pay for
the amount of time you use the bandwidth.

Bandwidth This parameter is mandatory when EIP is set to Automatically
Assign.
Specifies the bandwidth size in Mbit/s.

 
13. Set the BMS login mode.

– Key pair
A key pair is used for BMS login authentication. You can select an existing key
pair, or click View Key Pair and create one.

NOTE

If you use an existing key pair, ensure that you have saved the key file locally. Otherwise,
you will fail to log in to the BMS.

– Password
In this mode, the initial password is used for authentication. You can log in to the
BMS using the username and its initial password. If the BMS runs Linux, you can
use username root and its password to log in to the BMS. If the BMS runs
Windows, you can use username Administrator and its initial password to log in to
the BMS. The passwords must meet the requirements described in Table 3-2.
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NOTE

You cannot select this login mode for Windows BMSs.

Table 3-2 Password requirements

Parameter Requirements Example
Value

Password l Consists of 8 characters to 26 characters.
l Must contain at least three of the following

character types:
– Uppercase letters
– Lowercase letters
– Digits
– Special characters !@$%^-_=+[]{}:,./?

l Cannot contain the username or the
username in reverse.

l Cannot contain more than two characters in
the same sequence as they appear in the
username. (This requirement applies only to
Windows BMSs.)

Test12$@

 
14. (Optional) Configure Advanced Settings.

To use functions listed in Advanced Settings, click Configure now. Otherwise, click Do
not configure.
– User Data Injection enables the BMS to automatically inject user data when the

BMS starts for the first time. After this function is enabled, the BMS automatically
injects the user data upon its first startup. For detailed operations, see section
Injecting User Data into BMSs.

– Agency Name
An agency provides BMSs with temporary security credentials for accessing other
cloud services. The agency is created by the tenant administrator on the Identity and
Access Management (IAM) console. If you have created an agency on the IAM
console, you can select the agency name from the drop-down list and obtain
specified operation permissions.

15. Set BMS Name.
The name can be customized but can contain only letters, digits, underscores (_),
hyphens (-), and periods (.).
If you want to purchase multiple BMSs at a time, the system automatically sequences
these BMSs.

16. Set the validity period and purchase quantity.
– Validity Period: 1 month to 3 years

NOTE

BMSs charged in yearly/monthly mode cannot be deleted. They support only resource
unsubscription. If you do not want to use these BMSs any longer, click Fees in the upper
right corner. On the displayed Billing Center page, choose Unsubscriptions in the
navigation pane on the left and unsubscribe the BMS.
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– Purchase Quantity: 1 to 24

NOTE

If the quota is sufficient, you can purchase a maximum of 24 BMSs. If the quota is less than
24, you can purchase a maximum of all available BMSs.

17. Click Buy Now.
On the Order Details page, confirm the BMS information and click Submit Order.

NOTE

If you have any question about the price, click Price Details.

18. Pay the fees as prompted and click OK.
The BMS console is displayed.

19. After you pay the order, the system will create your requested BMSs.
The BMS status changes to Running after about 30 minutes.

NOTE

If you select a flavor that supports quick provisioning, you can obtain a BMS in about five
minutes.

After obtaining the BMS, you can change the password validity period to avoid any inconvenience
caused by image password expiry. For details, see How Do I Set the Password Validity Period?
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4 Logging In to a Linux BMS

You can only log in to a running BMS.

You can log in to a Linux BMS in either of the following ways:

l Logging in to a BMS using SSH
This option applies only to BMSs running Linux. You can use a remote login tool (such
as PuTTY) to log in to the BMS using the password or private key. An EIP must be
bound to the BMS.

l Remotely logging in to a BMS
If no EIP is bound to a BMS, you can remotely log in to the BMS from the management
console, but this only applies to Linux BMSs.

4.1 Login Using an SSH Key

Prerequisites
l An EIP has been bound to the BMS.
l You have obtained the private key for logging in to the BMS and stored the key in a local

directory.
l You have configured the inbound rules of the security group. For details, see

Configuring the Security Group.
l The network connection between the login tool (PuTTY) and the target BMS is normal.

For example, the default port 22 is not blocked by the firewall.

Logging In to the Linux BMS from a Windows Computer

To log in to the Linux BMS from a Windows computer, perform the operations described in
this section.

The following procedure describes how to log in to a Linux BMS using PuTTY. Before
logging in to the BMS using PuTTY, make sure that the private key file has been converted
to .ppk format.

1. Check whether the private key file has been converted to .ppk format.
– If yes, go to step 7.
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– If no, go to step 2.

2. Visit the following website and download PuTTY and PuTTYgen:

http://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html

NOTE

PuTTYgen is a private key generator, which is used to create a key pair that consists of a public
key and a private key for PuTTY.

3. Run PuTTYgen.

4. In the Actions area, click Load and import the private key file that you stored when
creating the BMS.

Ensure that the private key file is in the format of All files (*.*).

5. Click Save private key.

6. Save the converted private key to the local computer. for example, kp-123.ppk, to the
local computer.

7. Double-click PUTTY.EXE. The PuTTY Configuration page is displayed.

Figure 4-1 PuTTY Configuration

8. Choose Connection > Data. Enter the image username in Auto-login username.

9. Choose Connection > SSH > Auth. In the last configuration item Private key file for
authentication, click Browse and select the private key converted in step 6.

10. Click Session and enter the EIP of the BMS in the box under Host Name (or IP
address).
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11. Click Open.
Log in to a BMS.

Logging In to the Linux BMS from a Linux Computer
To log in to the Linux BMS from a Linux computer, perform the operations described in this
section. The following procedure uses private key file KeyPair-ee55 as an example to
describe how to log in to the BMS. The name of your private key file may be different.

1. On the Linux CLI, run the following command to change operation permissions:
chmod 600 /path/KeyPair-ee55

NOTE

In the preceding command, path refers to the path under which the key file is stored.

2. Run the following command to log in to the BMS:
ssh -i /path/KeyPair-ee55 xxx@ EIP of the BMS

NOTE

l In the preceding command, path refers to the path under which the key file is stored.
l xxx is automatically created during BMS provisioning. If the BMS runs Red Hat, the

username is rhel.

4.2 Login Using an SSH Password

Prerequisites
l An EIP has been bound to the BMS.
l You have configured the inbound rules of the security group. For details, see

Configuring the Security Group.
l The network connection between the login tool (such as PuTTY) and the target BMS is

normal. For example, the default port 22 is not blocked by the firewall.

NOTE

If you want to use the SSH password to log in a Linux BMS whose login mode is password, log in to the
BMS remotely and enable the SSH password login mode. For details, see How Should I Set SSH
Configuration Items?

Log In to the BMS from a Windows Server
To log in to the BMS from a Windows server, perform the following steps:

PuTTY is used as an example to describe how to log in to the BMS.

1. Run PuTTY.
2. Click Session, enter the EIP of the BMS in the text box under Host Name (or IP

address), and select SSH for Connection type.
3. Click Open.
4. Enter username root and the password to log in to the BMS.

Log In to the BMS from a Linux Server
To log in to the BMS from a Linux server, run the following command on the server:
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ssh EIP of the BMS

4.3 Remote Login

Restrictions and Limitations
l Only Linux BMSs support remote login.

l Only the user who creates a BMS or users with the Tenant Administrator or Server
Administrator role can log in to the BMS remotely.

l The remote login page does not support Chinese input or desktop GUI-based operations.

l When you log in to a BMS remotely, shortcut keys such as Ctrl and Alt are not well
supported. For example, if you enter Alt + ASCII code, multiple special characters are
displayed.

l If you select the key pair login mode when creating a Linux BMS, you must log in to the
BMS using the key pair (see section Login Using an SSH Key) and set a password
before you can remotely log in to the BMS. The detailed operations are as follows:

Log in to the BMS using the key pair, switch to user root, and run the passwd command
to set the password of user root.

Log In to a BMS
1. Log in to the management console.

2. Click  in the upper left corner and select the desired region and project.

3. Under Computing, click Bare Metal Server.

The BMS console is displayed.

4. Locate the row that contains a BMS and click Remote Login in the Operation column.

After about one minute, the login page is displayed. Press Enter and enter the username
and password to log in.

NOTE

l If you do not log in within 10 minutes after obtaining the remote login link, it will become
invalid.

l If you do not perform any operation on the remote login page within 10 minutes, you need to
obtain the link again.

l If the login page does not respond after you press Enter, a possible cause is that remote login
is not configured for the BMS image. You can resolve the issue by following the instructions
in What Can I Do If the Login Page Does Not Respond?

l If the BMS console is displayed improperly (such as broken lines and garbled characters) after
you remotely log in to it, see What Can I Do If the BMS Console Is Displayed Improperly
After I Remotely Log In to a BMS?
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5 Logging In to a Windows BMS

You can only log in to a running BMS.

You can log in to the Windows BMS by running MSTSC on a local server and using an
MSTSC password. This method applies only to the Windows BMSs. An EIP must be bound
to the BMS.

5.1 Login Using an MSTSC Password

Prerequisites
l An EIP has been bound to the BMS.
l You have obtained the private key for logging in to the BMS and stored the key in a local

directory.
l You have configured the inbound rules of the security group. For details, see

Configuring the Security Group.
l The network connection between the login tool and the target BMS is normal. For

example, the default port 3389 is not blocked by the firewall.

Logging In to the Windows BMS from a Windows Computer
The following procedure describes how to log in to a BMS using mstsc.exe.

1. After a Windows BMS is provisioned and configured, locate the row that contains the
BMS on the BMS console, click More, and select Obtain Password from the drop-
down list. Then select the local private key file for provisioning the BMS. Click Obtain
Password to obtain the BMS username and password.

2. On Windows, click Start and enter mstsc.exe. In the displayed remote desktop
connection window, enter the BMS EIP, username, and password obtained in step 1 to
log in to the BMS remotely.
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6 Initializing Data Disks

Scenarios
In the following scenarios, EVS disks can be used only after being initialized:

l A data disk is created when you create a BMS on the management console.
l An EVS disk is created on the EVS console, then attached to a BMS to be used as a data

disk.

This document uses CentOS 7.0 64-bit as an example. The method for formatting BMSs
varies depending on the OS. This section only provides reference. For information about how
to format BMSs running other types of OSs, see the corresponding OS product
documentation.

NOTICE
When using an EVS disk for the first time, if you have not initialized the disk, including
creating partitions and file systems, the additional capacity added to the disk in a later
expansion operation may not be normally used.

Prerequisites
l You have logged in to the BMS as user root.
l A data disk has been attached to the BMS and has not been initialized.

Creating Partitions and Attaching a Disk
The following operations are used as an example. When a new data disk is attached to the
BMS, the disk must be set as the primary partition in ext4 format and be automatically
attached to the /mnt/sdc directory upon start.

Step 1 Run the following command to query information about the added data disk:

fdisk -l

Information similar to the following is displayed:
[root@ecs-b656 test]# fdisk -l
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Disk /dev/sda: : 42.9 GB, 42949672960 bytes, 83886080 sectors
Units = sectors of 1 * 512 = 512 bytes
Sector size (logical/physical): 512 bytes / 512 bytes
I/O size (minimum/optimal): 512 bytes / 512 bytes
Disk label type: dos
Disk identifier: 0x000cc4ad

    Device Boot      Start         End      Blocks   Id  System
/dev/sda1   *        2048     2050047 1024000   83  Linux
/dev/sda2         2050048    22530047    10240000   83  Linux
/dev/sda3        22530048    24578047     1024000   83  Linux
/dev/sda4        24578048    83886079    29654016    5  Extended
/dev/sda5        24580096    26628095     1024000   82  Linux swap / Solaris

Disk /dev/sdb: : 10.7 GB, 10737418240 bytes, 20971520 sectors
Units = sectors of 1 * 512 = 512 bytes
Sector size (logical/physical): 512 bytes / 512 bytes
I/O size (minimum/optimal): 512 bytes / 512 bytes

The preceding information indicates that the BMS contains two disks. /dev/sda is the system
disk, and /dev/sdb is the newly added data disk.

Step 2 Run the following command to use fdisk to perform the partitioning operations for the added
data disk:

fdisk Newly added data disk

For example, run the following command to use fdisk to perform the partitioning operations
for the /dev/sdb data disk:

fdisk /dev/sdb

Information similar to the following is displayed:

[root@ecs-b656 test]# fdisk /dev/sdb
Welcome to fdisk (util-linux 2.23.2).
Changes will remain in memory only, until you decide to write them.
Be careful before using the write command.
Device does not contain a recognized partition table
Building a new DOS disklabel with disk identifier 0xb00005bd.
Command (m for help): 

Step 3 Enter n and press Enter to create a new partition.

Information similar to the following is displayed:

Command (m for help): n
Partition type:
   p   primary (0 primary, 0 extended, 4 free)
   e   extended

There are two types of disk partitions:
l Choosing p creates a primary partition.
l Choosing e creates an extended partition.

Step 4 Recreate the partition with the same partition type as before. In this example a primary
partition is used. Therefore, enter p and press Enter to create a primary partition.

Information similar to the following is displayed:

Select (default p): p
Partition number (1-4, default 1):

Partition number indicates the serial number of the primary partition. The value can be 1 to
4.
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Step 5 Enter the same partition number as the partition had before and press Enter. Primary partition
number 1 is used in this example.

Information similar to the following is displayed:

Partition number (1-4, default 1): 1
First sector (2048-20971519, default 2048):

First sector indicates the start cylinder number. The value can be 2048 to 20971519, and the
default value is 2048.

Step 6 Ensure that you enter the same first cylinder as the partition had before. In this example, we
previously noted down 2048, so we type in 2048 here and press Enter.

Information similar to the following is displayed:

First sector (2048-20971519, default 2048):
Using default value 2048
Last sector, +sectors or +size{K,M,G} (2048-20971519, default 20971519):

Last sector indicates the end cylinder number. The value can be 2048 to 20971519, and the
default value is 20971519.

Step 7 In this example, select the default end cylinder number 20971519 and press Enter.

Information similar to the following is displayed:

Last sector, +sectors or +size{K,M,G} (2048-20971519, default 20971519):
Using default value 20971519
Partition 1 of type Linux and of size 10 GiB is set
Command (m for help):

A primary partition has been created for a 10-GB data disk.

Step 8 Enter p and press Enter to view the details about the created partition.

Information similar to the following is displayed:

Command (m for help): p

Disk /dev/sdb: 10.7 GB, 10737418240 bytes, 20971520 sectors
Units = sectors of 1 * 512 = 512 bytes
Sector size (logical/physical): 512 bytes / 512 bytes
I/O size (minimum/optimal): 512 bytes / 512 bytes
Disk label type: dos
Disk identifier: 0xb00005bd

    Device Boot      Start         End      Blocks   Id  System
/dev/sdb1            2048    20971519    10484736   83  Linux

Command (m for help): 

Details about the /dev/sdb1 partition are displayed.

Step 9 Enter w and press Enter to write the partition result into the partition table.

Information similar to the following is displayed:

Command (m for help): w
The partition table has been altered!

Calling ioctl() to re-read partition table.
Syncing disks.

The partition is successfully created.

Step 10 Run the following command to synchronize the new partition table to the OS:
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partprobe

Step 11 Run the following command to set the format for the file system of the newly created
partition:

mkfs -t File system format /dev/sdb1

For example, run the following command to set the ext4 file system for the /dev/xvdb1
partition:

mkfs -t ext4 /dev/sdb1

Information similar to the following is displayed:

[root@ecs-b656 test]# mkfs -t ext4 /dev/sdb1
mke2fs 1.42.9 (28-Dec-2013)
Filesystem label=
OS type: Linux
Block size=4096 (log=2)
Fragment size=4096 (log=2)
Stride=0 blocks, Stripe width=0 blocks
655360 inodes, 2621184 blocks
131059 blocks (5.00%) reserved for the super user
First data block=0
Maximum filesystem blocks=2151677952
80 block groups
32768 blocks per group, 32768 fragments per group
8192 inodes per group
Superblock backups stored on blocks:
        32768, 98304, 163840, 229376, 294912, 819200, 884736, 1605632

Allocating group tables: done
Writing inode tables: done
Creating journal (32768 blocks): done
Writing superblocks and filesystem accounting information: done

The formatting takes a period of time. Observe the system running status, and do not exit.

NOTICE
The partition quantity and size supported by different file systems vary. Therefore, you are
advised to choose an appropriate file system based on your service requirements.

Step 12 Run the following command to create a mount point:

mkdir Mount point

For example, run the following command to create the /mnt/sdc mount point:

mkdir /mnt/sdc

Step 13 Run the following command to mount the new partition on the mount point created in Step
12:

mount /dev/sdb1 Mount point

For example, run the following command to mount the newly created partition on /mnt/sdc:

mount /dev/sdb1 /mnt/sdc

Step 14 Run the following command to view the mount result:

Bare Metal Server
Quick Start 6 Initializing Data Disks

Issue 01 (2018-06-20) 21



df -TH

Information similar to the following is displayed:

[root@ecs-b656 test]# df -TH
Filesystem     Type      Size  Used Avail Use% Mounted on
/dev/sda2     xfs        11G  7.4G  3.2G  71% /
devtmpfs       devtmpfs  4.1G     0  4.1G   0% /dev
tmpfs          tmpfs     4.1G   82k  4.1G   1% /dev/shm
tmpfs          tmpfs     4.1G  9.2M  4.1G   1% /run
tmpfs          tmpfs     4.1G     0  4.1G   0% /sys/fs/cgroup
/dev/sda3     xfs       1.1G   39M  1.1G   4% /home
/dev/sda1     xfs       1.1G  131M  915M  13% /boot
/dev/sdb1     ext4       11G   38M  9.9G   1% /mnt/sdc

The newly created partition /dev/sdb1 is mounted to /mnt/sdc.

----End

Setting Automatic Disk Attachment Upon BMS Start

To automatically attach a disk when a BMS starts, you should not specify its partition, for
example /dev/sdb1, in /etc/fstab. This is because the sequence of cloud devices may change
during the BMS stop and start, for example, /dev/sdb1 may change to /dev/sdb2. You are
advised to use the universally unique identifier (UUID) in /etc/fstab to automatically attach a
disk at system start.

Step 1 Run the following command to query the partition UUID:

blkid Disk partition

For example, run the following command to query the UUID of /dev/sdb1:

blkid /dev/sdb1

Information similar to the following is displayed:

[root@ecs-b656 test]# blkid /dev/sdb1
/dev/sdb1: UUID="1851e23f-1c57-40ab-86bb-5fc5fc606ffa" TYPE="ext4"

The UUID of /dev/sdb1 is displayed.

Step 2 Run the following command to open the fstab file using the vi editor:

vi /etc/fstab

Step 3 Press i to enter the editing mode.

Step 4 Move the cursor to the end of the file and press Enter. Then add the following information:
UUID=1851e23f-1c57-40ab-86bb-5fc5fc606ffa /mnt/sdc      ext4 defaults     0   2

Step 5 Press Esc, enter :wq, and press Enter.

The system saves the configurations and exits the vi editor.

----End
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7 (Optional) Installing One-Click Password

Reset Plugins

You can reset the password of a BMS using the password reset function provided on the
public cloud platform. If the password of your BMS is lost or expires and your BMS has the
password reset plugin Cloud-reset-pwd Agent installed, you can reset the password by a few
clicks.

This method is convenient and efficient. After you have created a BMS, you are advised to
log in to it and install the password reset plugins.

NOTE

l If you have installed the password reset plugin for the public image used to create the BMS, or have
installed the plugin during the private image creation, you do not need to install it again. To check
whether the plugin has been installed for the BMS, see step Step 1 in "Install the Password Reset
Plugins on a Linux BMS" or step Step 1 in "Install the Password Reset Plugins on a Windows
BMS".

l To uninstall the plugin, see Uninstall the Password Reset Plugins from a Linux BMS or Uninstall
the Password Reset Plugins from a Windows BMS.

Notes
1. This plugin is dedicated for BMSs and cannot be used for ECSs. In addition, do not use

any other password reset plugin except the plugin provided by the BMS service.
2. You can decide whether to install Cloud-reset-pwd Agent.
3. After installing the plugin, do not uninstall it. Otherwise, the management console may

fail to reset the password.
4. After you reinstall or change the OS of a BMS, the one-click password resetting function

will become invalid. If you want to continue using this function, reinstall Cloud-reset-
pwd Agent.

5. If you install Cloud-reset-pwd Agent after your BMS password has expired or been lost,
the one-click password resetting function will not take effect.

6. CloudResetPwdAgent can be automatically upgraded only if an EIP is bound to the
BMS. You can also download the upgrade package and upgrade CloudResetPwdAgent
manually.

7. The one-click password reset plugin CloudResetPwdAgent has been open-sourced in the
Github platform according to GNU General Public License v2.0.
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Prerequisites
l The BMS must be in Running state.
l A Windows BMS must have larger than 600 MB remaining space and data can be

written to its drive C.
A Linux BMS must have larger than 600 MB remaining space and data can be written to
its root directory.

l Ensure that DHCP is enabled in the VPC to which the BMS belongs.
l The BMS network connectivity is normal.
l Ensure that security group rules in the outbound direction meet the following

requirements:
– Protocol: TCP
– Port Range: 80
– Remote End: 169.254.0.0/16
If you use the default outbound security group rule, the preceding requirements are met,
and the BMS can be initialized. The default outbound security group rule is as follows:
– Protocol: ANY
– Port Range: ANY
– Remote End: 0.0.0.0/16

Install the Password Reset Plugin on a Linux BMS

Step 1 Check whether CloudResetPwdAgent and CloudResetPwdUpdateAgent have been installed
on the BMS.

1. Log in to a BMS.
2. Check whether CloudResetPwdAgent has been installed. To check this, perform the

following operations:

a. Check whether the CloudrResetPwdAgent directory exists in the root directory of
the BMS.

b. Run the following command to check whether the status of CloudResetPwdAgent is
unrecognized service:
service cloudResetPwdAgent status

If the CloudResetPwdAgent directory exists in the root directory of the BMS and the
status of CloudResetPwdAgent is not unrecognized service, CloudResetPwdAgent has
been installed on the BMS.
– If yes, go to step Step 1.3.
– If no, go to step Step 2.

3. Check whether CloudResetPwdUpdateAgent has been installed. To check this, perform
the following operations:

a. Check whether the CloudResetPwdUpdateAgent directory exists in the root
directory of the BMS.

b. Run the following command to check whether the status of
CloudResetPwdUpdateAgent is unrecognized service:
service cloudResetPwdUpdateAgent status
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If both of the preceding conditions are met, CloudResetPwdUpdateAgent has been
installed on the BMS.
– If yes, no further action is required.
– If no, go to step Step 2.

Step 2 Download password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

Download and decompress CloudResetPwdAgent.zip.

Download path: http://bms-image-package.obs.myhwclouds.com/linux/reset_pwd_agent/
CloudResetPwdAgent.zip

Step 3 Install password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

1. Copy the files extracted in step Step 2 to the same directory of the BMS (otherwise, the
installation will fail).

NOTE

There is no special requirement for the directory. You only need to ensure that the extracted files
are in the same directory.

2. Run the following command to open the CloudResetPwdUpdateAgent.Linux file:
cd CloudResetPwdUpdateAgent.Linux

3. Run the following command to add the execute permission for the setup.sh file:
chmod +x setup.sh

4. Run the following command to install the plugins:
sudo sh setup.sh

5. Run the following commands to check whether the installation is successful:
service cloudResetPwdAgent status
service cloudResetPwdUpdateAgent status
If the status of CloudResetPwdAgent and CoudResetPwdUpdateAgent is not
unrecognized service, the installation is successful. Otherwise, the installation fails.

NOTE

If the installation fails, check whether the installation environment meets requirements and install
the plugin again.

----End

Install the Password Reset Plugins on a Windows BMS

Step 1 Check whether CloudResetPwdAgent and CloudResetPwdUpdateAgent have been installed
on the BMS. To check this, perform the following operations:

Start the Task Manager and check whether cloudResetPwdAgent and
CloudResetPwdUpdateAgent are displayed on the Services page.

l If yes, no further action is required.
l If no, go to step Step 2.

Step 2 Download password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

Download and decompress CloudResetPwdAgent.zip.
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Download path: http://bms-image-package.obs.myhwclouds.com/windows/reset_pwd_agent/
CloudResetPwdAgent.zip

Step 3 Install password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

1. Copy the files extracted in step Step 2 to the same directory of the BMS (otherwise, the
installation will fail).

NOTE

There is no special requirement for the directory. You only need to ensure that the extracted files
are in the same directory.

2. Double-click the setup.bat file in the CloudResetPwdUpdateAgent.Windows
directory.
Install the password reset plugins.

3. View the Task Manager to check whether the installation is successful.
If you can find cloudResetPwdAgent and cloudResetPwdUpdateAgent in the Task
Manager, the installation is successful. Otherwise, the installation fails.

NOTE

If the installation fails, check whether the installation environment meets requirements and install
the plugin again.

----End

Uninstall the Password Reset Plugins from a Linux BMS
Log in to the BMS and run the following commands:

1. sudo bash /CloudrResetPwdAgent/bin/cloudResetPwdAgent.script remove
2. sudo bash /CloudResetPwdUpdateAgent/bin/cloudResetPwdUpdateAgent.script

remove
3. sudo rm -rf /CloudrResetPwdAgent
4. sudo rm -rf /CloudResetPwdUpdateAgent

Uninstall the Password Reset Plugins from a Windows BMS
1. Log in to the BMS and go to the C:\CloudResetPwdUpdateAgent\bin directory.
2. Double-click UninstallApp-NT.bat.
3. Delete C:\CloudResetPwdUpdateAgent.
4. Go to the C:\CloudResetPwdAgent\bin directory.
5. Double-click UninstallApp-NT.bat.
6. Delete C:\CloudResetPwdAgent.
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8 Change History

Release Date Description

2018-06-20 This issue is the first official release.
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